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Manuel de Symbolisation pour Microstation (carte 1/5,000)
 
<Objectif>
Symboliser la carte à l’échelle de 1/5.000 en utilisant le logiciel de “Microstation”. 
 
1. Symbolisation de point (pour Cellule) 
 
1.1 Faire une simple cellule 
 
Couche 3005- petit bâtiment 

 

 
Pour réaliser un fichier cellule, sélectionner Element | Cells. 
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La fenêtre de « Cell Library » s’affiche. 

 
 
Sélectionner File | New 
La fenêtre « Create Cell Library window» s’ouvre. 
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Saisir « cel_exercise » puis cliquer sur OK. 

 

 
Le fichier « cel_exercise.cel » sera créé et s’ouvrira. 
 
Changer la couche (level) active, puis la paramétrer sur « Default ». 

 
Faire une cellule à la couche « Default » est conseillé.  
La cellule peut être utilisée à toutes les couches. 
Si vous faites une cellule à une autre couche, celle-ci ne peut être utilisée à d’autres. 
 
 
Puis commencer pour créer une cellule de “petit bâtiment”. 

 
Travail à l’échelle réelle en MicroStation, exprimée à 1mm sur la carte. 
 
Ensuite, vous devez donner un point d’origine à cette cellule.  
Le point d’origine du symbole de l’ « Habitat précaire » doit être le centre du carré.  
 

 
Cliquer sur « Define Cell Origin ». 
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Snap Mode --- Center Snap 
Déplacer votre curseur pour vous rapprocher de l’objet. 
Le symbole Snap apparaît au centre de l’objet, alors, cliquer dessus. 

 
Voici le point d’origine de la cellule. 
 
Alors, placer un contour autour de l’objet.  
Ainsi, le bouton « Create » de la fenêtre « Cell Library » s’active 

 

 
Cliquer sur le bouton « Create ». 
 
La fenêtre « Create New Cell » s’ouvre; saisir le nom de cellule « 3005p ».  
Cliquer sur « Create ». 

 
 
La cellule « 3005p » apparaît dans la fenêtre « Cell Library » et sera créée dans le fichier« .cel ». 
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1.2 Créer un motif 

 

 
Vous pouvez arranger les cellules modélisées dans les zones polygonales. 
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Placer un motif oblique 
 

 
Au préalable, créer une cellule tournée à -45°. 
 
Choisir un objet. 

 

Cliquer sur le bouton « Pattern Area ». 
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La fenêtre de « Pattern Area » s’ouvre. 

 
Saisir le nom de la cellule dans la cellule de texte des Modèles. 
Changer l’échelle de 0 à 1. 
L’espacement des rangées --- 20 
L’espacement des colonnes --- 20 
L’angle --- 45 
 
Puis cliquer quelque part dans Vue1. 
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2. Symbolisation des lignes 
 
2.1 Lignes normales 
Couche 2005 ligne « Sentier » 

 

 
Cette ligne consiste en un modèle de tirets de 15m et d’écarts de 5m. 

 

 
Élément | Styles des Lignes | Éditer 

 

Fichier | Nouveau 
Saisir « line_exercise » puis cliquer sur OK. 
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Edit | Create | Stroke Pattern 

 
 

Cliquer sur le bouton « Add », changer la longueur à 15 dans la zone de texte et changer le « Stroke 
Type », « Dash ». 
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Cliquer sur le bouton « Add » et cliquer sur le carré nouvellement apparu. 

 
 
Ensuite, changer la longueur à « 2.5 » dans la zone de texte. 
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Le modèle de ligne est réalisé.  
Donner alors un nom à cette ligne.  
Effacer le « new stroke component » et saisir sa description. 
Ex. «7.5_2.5» 
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And Edit | Create | Name 

 
 
Effacer « unnamed » et saisir « 2007 line » 
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Vous devez enregistrer ce fichier, File | Save dans cette fenêtre. 
Mais cette ligne ne peut être encore utilisée dans un fichier DGN.  
Vous devez donc importer cette information de style de ligne à partir de ce fichier vers DGN. 
 
File | Import | MicroStation Resource File (RSC)… 

 
 
Sélectionner « line_exercise.rsc » puis cliquer sur « open ». 
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Sélectionner cette ligne puis cliquer sur le bouton « Import ». 

 

Vous pouvez alors utiliser ce style de ligne dans votre DGN. 
 
Cliquer sur le bouton de « Active Line Style », 

 
dérouler… 
Et sélectionner le style de ligne. Vous pouvez alors utiliser cette ligne dans votre DGN. 
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2.2 Lignes complexes 
Ligne de “Frontière” utilisée à la couche 1001. 

 

 
 
 
 

 
Cette ligne consiste en une ligne modélisée (traits de 5m et écarts de 2.5m) et des coches de 5m de 
longueur. 

 

 
Premièrement, faire une ligne de 5-2.5. 
Dans la fenêtre « Line Style Editor », Edit | Create | Stroke Pattern 
Ajouter des traits de 5m, ajouter des écarts de 2.5m et saisir la description, ex. « 5-2.5 ». 
 
Ensuite, dans la fenêtre « Line Style Editor », Edit | Create | Point 
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La fenêtre « Line Style Editor » changera.  
Dessiner une ligne de 5m dans la fenêtre Vue 1, 

 
 
Donner le point d’origine de cette ligne, utiliser « Define Cell Origin » 
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Et placer une boite de contour autour de ce point. 

    

Dans la fenêtre « Line Style Editor », le bouton « Create… » s’active, cliquer dessus. 
 
La fenêtre « Create Point Symbol » s’ouvre. Saisir un nom comme « 1001 tick » puis cliquer sur « OK ». 
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Saisir la description comme «1001tick». 

 
 
Ensuite, cliquer sur le bouton « Base Stroke Pattern», choisir « 5_2.5 » et « OK ». 
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Cliquer sur la partie de la ligne « Dash» car le coche doit être attaché à cette partie.   
Cliquer sur le bouton « Select ». 
 
Sélectionner « 1001 tick » et cliquer sur « OK ». 
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Puis les traits de « 5_2.5 » et les points de « 1001 tick » sont réalisés. 
 

 
 
Ensuite, entourer ces composants. 
Edit | Create | Compound 

 
 

Créé par l’équipe d’études de JICA 



ETUDE SUR L’ETABLISSEMENT D’UNE BASE DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE LA VILLE DE 
BUJUMBURA 

Manuel pour Symbolization I 

22/43 

 
Cliquer sur le bouton « Insert… ». 

 
 
Sélectionner «Stroke 5_2.5» et cliquer sur « OK ». 
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Cliquer sur « Insert… » à nouveau puis sélectionner « Point 1001 tick ». 

 
 
Changer description.  Par exemple, ”Border”. 

 
 

 
And Edit | Create | Name.  Saisir «1001 line». 
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Et sélectionner File | Save dans cette fenêtre. 

 
 
Importer cette ligne à partir de ce fichier « .rsc » vers DGN à nouveau. 
Fichier | Importer | Fichier de Ressource MicroStation (RSC) 
Sélectionner ce fichier et l’ouvrir. 
 
Sélectionner « 1001 line » et cliquer sur « Importer ». 
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La « 1001line » colorée de rouge est déjà importée et n’a pas besoin d’être choisie cette fois. 

 
Vous pouvez alors utiliser ce style de ligne dans votre fichier DGN. 
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3. Créer Tableaux 
 
3.1 Fichier de Table 
Si ce fichier DGN est imprimé sans aucune d’autre opération, la carte sera mal représentée, étant difficile 
à lire comme présentée ci-dessous. 

 
 
Vous devrez donc revoir certains paramétrages de tableaux. 

 
Dans ce cas, il est nécessaire de changer l’ordre de couches, couleurs et largeur des lignes du tableau. 
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3.2 Ordre de Couche (Level) 
Ces données DGN utilisent 16 couches. 

 

 
Premièrement, diviser ces niveaux en trois groupes. 
 

 
 
1). Ordre 1(level: 0_neatline, 3126, 4117 6012, 9000) 

 

Créé par l’équipe d’études de JICA 



ETUDE SUR L’ETABLISSEMENT D’UNE BASE DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE LA VILLE DE 
BUJUMBURA 

Manuel pour Symbolization I 

28/43 

2). Ordre 2(level: 2001, 3001, 3002, 3005, 4119, 4201) 

 

3). Ordre 3(level: 2002f, 3002f) 

 

4). Ordre 4(5107) 

 
5). Ordre 5(5107_pol) 
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File | Print 
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Sélectionner les niveaux (level: 0_neatline, 3126, 4117, 6012, 9000), puis cliquer sur « OK ». 

 
Le nom de niveau sélectionné apparaît sur le côté droit du bouton de niveau. 
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Cliquer sur l’onglet d’ « Element Output Actions ». 

 
 
Cocher la case des « Priority » et saisir « 5 » dans sa zone de texte. 

 

 
 
L’ordre dépend du nombre.  
Les groupes de grands nombres expriment un haut rang et ceux de petits nombres un faible rang. 
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Changer le nom de ce groupe et double-cliquer sur « NEW ». 

 
 
Saisir « order1 » et cliquer sur « OK ». 

 

 
 
Ensuite, créer un groupe de niveau « order2 ». 
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Edit | Insert New Section Below… 

 
 
Saisir « order2 » et cliquer sur « OK ». 
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Cliquer sur l’onglet « Element Selection Criteria ». 

 
 
Cliquer sur « Level… ». 
Sélectionner les niveaux (2002, 3001, 3002, 3005, 4119, 4201) et cliquer sur « OK ». 
Cliquer sur l’onglet « Element Output Actions ».   
Cocher la « Priority » et saisir « 4 ». 
 
Ensuite, faire « order3 ». 
Éditer | Insérer une Nouvelle Section En Bas. 
Saisir « order3 » et cliquer sur « OK ». 
Cliquer sur l’onglet « Element Selection Criteria ».   
Cliquer sur « Level… ». 
Sélectionner les niveaux (2002f, 3003f) et cliquer sur “OK”. 
Cliquer sur l’onglet « Element Output Actions ».   
Cocher la « Priority » et saisir « 3 ». 
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Ensuite, faire «order4». 
Edit | Insert New Section Below . 
Saisir «order3» and “OK”. 
Cliquer sur l’onglet «Element Selection Criteria». 
Cliquer sur « Level… ». 
Sélectionner levels (5107) et « OK ». 
Cliquer sur l’onglet «Element Output Actions». 
Cocher la « Priority » et saisir « 2 ». 
 
Finallement, faire «order5». 
Edit | Insert New Section Below . 
Saisir «order3» and “OK”. 
Cliquer sur l’onglet «Element Selection Criteria». 
Cliquer sur « Level… ». 
Sélectionner levels (5107_pol) et « OK ». 
Cliquer sur l’onglet «Element Output Actions». 
Cocher la « Priority » et saisir « 1 ». 
 
Le processus de division des niveaux est terminé. 
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3.3 Changement de couleurs 
Le DGN utilise 7 couleurs. 

 
Ainsi, ce tableau change la couleur des routes (level 2001f), bâtiments (level 3002f) et de l’eau 
( 5107_pol) en des couleurs pâles. 
Les routes (2001f) utilisent la couleur No.3 tandis que les bâtiments (3002f) utilisent la couleur No.102 et 
de l’eau (5107_pol) utilisent la couleur No.7 

 
Dans la fenêtre «Modify Pen Table», cliquer sur le bouton « Map colors… ». 

 
 
Cliquer sur le bouton « Create ». 
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Double cliquer sur « 3 ». 

 
 
La fenêtre « Edit Pen Map(s) » s’affichera. 
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Cliquer sur « Do not define print screening factor » et sélectionner « Define print screening factor ». 

 
 
Changer la valeur de « Screening factor » à 30 puis cliquer sur « OK ». 

 

 
 
Ensuite, changer la couleur des bâtiments.  
Double-cliquer sur “102” 
Cliquer sur « Do not define print screening factor » et sélectionner « Define print screening factor ».  
Changer la valeur de « Screening factor » à 30 puis cliquer sur « OK ». 
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Finalement, changer la couleur de l’eau. 
Double-cliquer sur “7”. 
Cliquer sur « Do not define print screening factor » et sélectionner « Define print screening factor ».  
Changer la valeur de « Screening factor » à 30 puis cliquer sur « OK ». 
 
 
Le paramétrage des couleurs est terminé. Cliquer sur « OK » dans la fenêtre « Pen Table ». 
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3.4 Changer le poids des lignes 

 

Ce DGN utilise 3 types de poids de ligne (0, 1, 2). 
Ce tableau définit la largeur de ces lignes. 
Poids 0  0,1mm 
       1  0,15 mm 
       3  0,2mm 
 
Cliquer sur le bouton « Map weights…. ». 

 

 
Cliquer sur le bouton « Create ». 
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Double cliquer sur « 0 ». 

 
 

 
Cette fenêtre apparaît, changer la valeur de largeur d’impression à « 0,1 » puis cliquer sur « OK ». 

 
 
 
La largeur d’impression du poids « 0 » change. 
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Changer les valeurs de «  1 » et « 2 » de la même manière.  
Double-cliquer sur « 1 », changer la valeur à « 0,15 » puis cliquer sur « OK ». 
Double-cliquer sur « 2 », changer la valeur à « 0,2 » puis cliquer sur « OK ». 
 

 
Cliquer sur le bouton « OK » de la fenêtre « Pen Table». 
 
File | Save dans la fenêtre « Modify Pen Table » puis terminer. 
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Manuel de Symbolisation pour Illustrator (carte 1/25.000)

<Objectif>
Symboliser carte 1/25.000 utilisant le logiciel «Illustrator». 

1. Préparation de la zone d’étude 

1.1 Ouvrir un fichier nouveau 
1) Choisir File > New, puis saisir un nom dans la boîte de texte. 

2) Cliquer le button «Advanced», 

et choisir la mode de couleurs (CMYK).  

3) Si nécessaire, spécifier la hauteur et la larger pour le artboard. 
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1.2 Changer la taille du «Artboard» 

1). Choisir File > Document Setup. Puis choisir «Artboard» du menu «pop-up»en haut à gauche dans le  
« Document Setup dialog box». 

2). Exécuter les travaux ci-dessous: 
Choisir la taille préalablement programmée de la «Size pop-up menu». 

Choisir «Custom» de la «Size pop-up menu», et saisir la dimension dans la boîte de texte, jusqu’à 227 pouce 
(inch) de côté. Le changement de l’unité dans le document (donc la taille de «artboard») par sélection de la 
unité differente vient du Edit > Preferences > Units... dialog box  

3). Click OK. 

Fixer l’unité de carte et l’environnement du travail  2.
1). Général 
Choisir Edit > Preferences > General  
Dans le « Keyboard Increment text box », saisir la 
longueur avec la touche de flèche pour bouger la 
sélection, et puis Cliquer OK. 

Vérifier « Japanese Crop Marks ». « Japanese Crop 
Marks » arrive sur la carte. 
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2). Unité (Unit)...
Choisir Edit > Preferences > Units... 
Choisir Millimeters du popup menu «General:» 
Choisir Millimeters du popup menu of« Stroke:» 
Choisir Points du popup menu of «Type:» 

3). Options de l’emploi du trait d’union: 
Choisir Edit > Preferences > Hyphenation  
Choisir la langue (français) à laquelle la régle de 
l’emploi du trait d’union est appliquée dans la      
« Langue pop-up menu ». Quand vous selectionnez 
une lanque differente, la régle d’emploi du trait 
d’union change et s’ajuste à cette langue.

4). Guides et Grille (Grid)
Choisir Edit > Preferences > Guides & Grid  
Configurer les options pour les guides et la grille: 
pour la couleur. Choisir une couleur pour le guide, 
ou le grille, ou les deux. Si vous sélectionnez 
l’autre (other), cliquer la boîte de couleur, Choisir 
une couleur à partir du cueilleur de couleur (color 
picker), et cliquer OK.  
Pour le style, choisir l’option de vitrine pour les 
guides, ou la grille, ou les deux.  
Pour «Gridline Every», saisir une nouvelle valeur 
(et l’unité de measure si nécessaire) pour 
l’espacement des lignes de grille primaires. 
Pour la subdivision, saisir la valeur à subdivider la grille. 
Pour «Grids in Back», sélectionner l’option à montrer la grille derrière tout «artwork»; désélectionner 
l’option pour montrer la grille devant tout «artwork». 
Cliquer OK. 
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3. Fixation de couleurs 

Cette fonction est utilisée à fixer la couleur pour l’impression d’offset. 5 couleurs sont utilisées : noir, 
blue, vert, café et chocolat, dont les exemples sont présentés ci-dessous. 

3.1 Noir et Blanc 
Blanc utilise CMYK 0 %, Noir utilise C=0 M=0 Y=0 K=100%. Les deux (Noir et Blanc) existent dans 
«Swatches Palette» par défaut. 

3.2 Couleurs spécialement préparées (Spot colors)
Les couleur du blue, vert, café et chocolat vont être créées comme ci-dessous: 
En cas de vert: 

1) Ouvrir «Swatches palette»: Choisir window > 
Swatches. Cliquer le boutton de flèche en haut 
à droite de Swatches palette, et puis choisir 
New swatches. 

2) Saisir “green” dans «Swatch Name text box», 
Choisir “Spot Color” du pop up menu du 
«Color Type», choisir “CMYK” du pop up 
menu de la «Color Mode». Puis saisir le 
chiffre de % dans la boîte de texte comme 
l’exemple : C = 60, M = 0, Y = 75 et K = 0. 
Cliquer OK. 
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4. Symbolisations

4.1 Figure de Ligne  

1) Ligne simple 

 (1) La ligne simple est créée par une couleur comme courbe normale (couche 7102):  

A) Appliquer le grosseur (weight) des 

lignes:

Sélectionner la courbe de niveau avec 
des outils de la sélection. 
Montrer les traits (stroke): Choisir 
window > Stroke. 
Saisir 0,2mm dans la boite de texte
de Grosseur (Weight).
Choisir «Cap and Corner» avec 
l’icône.

B) Appliquer couleur: 

Sélectionner Courbe de niveau avec des outils de la séléction.
Montrer couleur palette: Choisir window > Color.  
Choisir fill      et cliquer none     Choisir stroke       

Puis choisir Sepia du Swatches palette. 
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(2) La ligne créée par les tirets comme courbe de niveau 
intermédiaire (couche 7103): 

Appliquer poids des lignes même que (1).A)  Puis vérifier la 

ligne en tirets. Saisir la longueur de tirets et l’écart comme 

l’exemple : tiret 2,5mm, écart 0,5mm. 

B) La couleur de ligne doit être appliquée avec la palette 

couleur comme (1). 

(3) Rangées d’arbres (couche 6011) 

Appliquer poids des lignesA)  0,5mm à saisir dans la boite de 

texte de grosseur (weight). Sélectionner «Round Cap». 

Puis verifier la ligne en tiret. Saisir la longueur de tirets et 

l’écart comme l’exemple : tiret 0mm, écart 1mm. 

B) Le vert doit être applqué comme couleur de ligne, au 

moyen de color palette comme (1). 

Remarque: Copier la ligne ci-dessus et faire passer au 
devant : Choisir Edit > pass in front. Puis appliquer 
0,4mm comme grosseur de ligne. La tête (cap), le tiret 
et l’écart sont mêmes que ci-dessus. Appliquer la 
couleur de ligne CMYK 0. 
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2) Lignes créée par multi-couleur 
 (1) Route nationale divisée, avec le terre-plein central. 
(couche 2001) 

A) Sélectionner une ligne avec selection tool. Puis 

appliquer lpoids des lignes 1,1mm, stroke color

K 100% CMYK color model. 

B) Modifier le nom de couche: Double-cliquer 
layer ou sélectionner layer, et puis cliquer le 
boutton en haut à droite de la boite de couche 
(layers box), puis choisir “Option for….”. 

«Layer Options box» apparaît. Saisir le nouveau 
nom dans la boîte de texte de nom. Cliquer OK. 

C) Créer une nouvelle couche (2001fr) en 
dupliquant la couche (layer) de 2001: 
Sélectionner la couche 2001, et puis cliquer le 
bouton en haut à droite de boîte de couche 
(layer box), choisir “Duplicate 2001”.  La 
couche “2001 copy” apparaît. Et changer le 
nom de couche en “2001fr”. 
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D) Appliquer le grosseur (weight) de ligne et la 
couleur pour la couche 2001fr. Sélectionner les 
objets de 2001fr avec l’outil de selection. 
(Sélectionner tous les objets en même temps 
s’il existe beaucoup d’objets dans une couche: 
Choisir > select > All) 

Saisir 0,6mm dans la boîte de texte de grosseur 
(weight), appliquer la couleur de café 100%.  

 

E) Créer une nouvelle couche (2011) en 
dupliquant la couche de 2001fr: Même 
mèthode que ci-dessus. 

F) Appliquer le grosseur de ligne et la couleur 
(stroke color) pour la couche 201c: Même 
mèthode que ci-desous. 

Line weight 0.2mm, Stroke color K 100% 
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3) Lignes créées par ligne d’offset 
Symbole minimal de clôture (couche 4201): 
A) Sélectionner une ligne de clôture en utilisant 

l’outil de sélection. Appliquer le grosseur de 
ligne de 0,2mm et la couleur K100. 

B) Sélectionner une ligne de cloture (Fence) en 
utilisant l’outil de sélection. Choisir Object > 
Path > Offset Path. «Offset Path dialogue 
box» va apparaître. Saisir la longueur d’offset 
de 0,25mm (moitié de la longueur de coche) 
dans la boite de texte d’Offset. Choisir 
“Bevel” du Joins pop-up menu. Cliquer OK. 

 

C) Couper la ligne ci-dessus créée par la voie 
d’offset en utilisant l’outil de ciseaux. Puis 
effacer une ligne inutile. 

 
D) Sélectionner la ligne restante avec la même 

méthode que ci-dessus. Appliquer poid des 
lignes 0,5mm (longueur de coche). Saisir 
chaque longueur dans dash et gap text box.
(tiret 0,2mm, écart 4,8mm) 
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4.2 Figure de Point  
1) Symboles simples 
 (1) Petit bâtiment (couche 3002) 
A) Sélectionner l’outil de rectangle. Cliquer n’importe 

quel point sur le document où vous voulez dessiner un 
point. Saisir 0,5mm dans la boîte de texte (Largeur et 
Hauteur). Cliquer OK. Puis remplir la couleur K 100. 

         
(2) Bureau Provincial (couche 3112) 
A) Sélectionner l’outil d’Ellipse. Cliquer n’importe quel 

endroit sur le document où vous avez besoin de 
dessiner un point. Saisir 2,2 mm dans la boîte de texte 
texte (Largeur et Hauteur). Cliquer OK. Puis appliquer 
stroke color K 100, fill none, ligne weight 0,1mm. 

     
B) Sélectionner l’objet ci-dessus en utilisant l’outil de 

sélection. Puis choisir Object > Transform > Scale. Et 
vérifier «Uniform» et saisir 20% (20% de 1mm = 
0,2mm). Cliquer Copy.  Appliquer fill color K 100. 
Sélectionner tous les deux objets. Choisir Object > 
Group.
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2) Symboles créés par la combination de figures simples 
 (1)  Eglise catholique (couche 3104) 
A) Dessiner un carré 1,75mm x 1,75mm.(Regardez 4.2.1).(1). Appliquer poid des lignes 0,15mm, stroke color

K 100. 

B) Sélectionner l’outil de «Ligne Segment». 

Cliquer un endroit à dessiner sur artboard.  

Saisir la longueur de 2mm, Angle 0. 
Appliquer poids des lignes 0,1mm, stroke color K 100. 

C) Sélectionner une ligne en utilisant 
l’outil de sélection. Choisir Object > 
Transform > Rotate ou double cliquer 
l’outil de «Rotate». Puis saisir 90 dans 
la boîte de texte (Angle). Cliquer Copy.

D) Fixer une croix et un carré. Finalement 
appliquer group à tous les objets. 

Créé par l’équipe d’études de JICA



ETUDE SUR L’ETABLISSEMENT D’UNE BASE DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE LA VILLE DE 
BUJUMBURA 

Manuel de Symbolisation I1

12/18

4.3 Figure de Polygone  

A) Dessiner un polygone en utilisant n’importe quel outil. Puis appliquer ligne color, fill color, ligne
weight, et ligne type. S’il faut appliquer un motif pour remplir, choisir Window > Swatches. Choisir 
un motif (motif) du Motif Palette. 

Polygone avec la ligne de tiret    Polygone peinteen vert        Polygone rempli avec un motif 
B) Exclure le polygone de doughnut en cas de besoin. Sélectionner les deux polygones, ensuite l’exclure 

en choisissant Object > Compound Path > Make. 
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4.4 Texte 

1) Texte (Horizontal ou Vertical) 
A) Sélectionner «Type tool». 

 

 
Cliquer un endroit à taper les lettre. Et puis taper lettres. 
 
 

B) Sélectionner le texte en utilisant l’outil de sélection. Montrer la boite de caractère: Choisir window > 
Type > Character. Puis changer la police, la taille, etc. en cas de besoin. 

Appliquer la couleur de texte en utilisant la couleur à remplir (fill color).

C) Si le déplacement de la ligne de base de texte est nécessaire, sélectionner un texte nécessaire à 
déplacer en utilisant «text tool». Puis choisir le point à partir de «baseline shift pop-up menu». 

2) Texte au bord de rivière 
A) Sélectionner une ligne de rivière. Puis bouger avec 

la clé d’Alt bordant la rivière. Une autre ligne 
apparaît au bord de la rivière. Appliquer la couleur 
comme «none-fill» et «none-stroke». 

B) Sélectionner une ligne avec l’outil de type cours 
(path). Puis taper un nom de la rivière. La police, la 
taille et l’espace d’ajustement sont editable avec la 
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boite de caractère  si nécessaire. 
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5. Records de Symboles et Motifs 
Création de symboles et motif n’est pas un par un dans une procédure de la symbolization de carte. Si 
symbols sont déjà preparé, pluseurs places sont necessaire pour stockage. Explication comme stocker 
Symboles et Motifs. 
5.1 Symboles de point 

A) Sélectionner objets qui est necessaire être stocké. Puis 
montrer brush: Choisir window > Brushes. Cliquer le 
button en haut à droite de Brushes box. Et Sélectionner 
New Brush. 

B) Vérifier «New Scatter Brush». 

C) Ensuite saisir le nom de symbole dans la boîte de texte de nom. Fixer chaque boîte comme suit : 

Taille 100 % Fixée,  l’espacement 1 %  Fixé, Dispersion 0 % Fixée, Rotation 0 % Fixée, Rotation 
relative à Page. 

D) Ensuite cliquer OK. 

E) Si vous avez besoin d’editer l’objet Brush comme l’objet isolé, changer l’objet Brush à objet isolé 
comme ci-dessous: 

Sélectionner «brush object». Puis choisir Object > Expand appearance. 
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5.2 Motif (Pattern)
Suivre ce guide général pour la création du motif de carreau: 

Pour créer le motif de carreau, faire un zoom sur l’«artwork» afin d’aligner précisément chaque 
élément, et puis faire un zoom arrière de l’«artwork» pour la sélection finale. 

Dans le cas où le motif serait complexe, la zone sélectionnée pour créer un motif doit être petit. 
Cependant, si la zone sélectionnée et le motif de carreau sont petites, le nombre de carreaux nécessaires 
pour la création du motif s’augmente. Par conséquent, si l’on utilise le carreau dont le côté est 2cm, on 
peut créer le motif plus efficacement que le carreau dont le côté est 0,5cm. Lorsqu’on crée le motif d’une 
façon régulière, on peut définir le motif de carreau, en créant nombreuses copies de l’objet.   

Lorsqu’on crée le motif de ligne d’une façon régulière, on crée le motif de carreau, en superposant les 
lignes dont la grosseur et la couleur sont différentes, et en disposant à l’arrière-plan une boîte marquant le 
contour, sans peinture ni lignes.  

Dans le cas où on créerait un motif irrégulier tel que le cuir et le tissu, il est efficace de transformer 
subtilement l’«artwork». On peut déformer l’objet, en appliquant l’effet de rugosité.  

Lorsqu’on rend lisse la pose du carrelage, on définit le motif par « close paths ». 

Avant la définition de motif, on agrandit la vue d’«artwork», et vérifie des détails  

Si on dessine une boîte marquant le contour (bounding box) autour de l’«artwork», il faut disposer une 
boîte en rectangle sans peinture ni lignes, à l’arrière-plan du carreau. Lorsqu’on utilise la boîte marquant 
le contour (bounding box) pour un motif de «brush», il faut s’assurer que rien ne dépasse en dehors de la 
boîte.

 
 

Exemple: Terrain cultivé (couche 6006)
A) Créer le symbol : Dessiner 3 lignes en utilisant Ligne

segment tool ci-dessous: 1mm de longueur. Angles 
sont 45°, 90° et 135°. Puis appliquer le grosseur 
(weight) 0,1mm, la couleur vert 100. 
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B) Sélectionner l’objet ci-dessus. Puit choisir Object > 
Transform > move. et saisir 3,5mm dans la boîte de 
texte Horizontal et Vertical. Cliquer «Copy». 

C) Créer une boîte bornant le motif : Sélectionner l’outil 
de Rectangle, puis saisir la longueur dans chaque boîte 
de texte ci-dessous: Largeur 7mm, signifie 2 fois de 
longueur horizontale et verticale distance entre un 
symbole et l’autre symbole. Puis cliquer OK. Et 
appliquer non «fill» et non «stroke color». 

D) Déplacer cette boîte bornant le motif afin d’entourer 
ces symboles. 

E) Sélectionner la boîte bornant (Bounding box). Puis 
choisir Object > Arrange > Send to Back. 

F) Sélectionner tous les symboles et la boîte bornant. Puis choisir Edit > Define Pattern. Saisir le nom de 
motif dans le «Swatch Name text box». Cliquer OK. Ca va être stocké dans «Swatches palette». 
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Manuel de Structuration de Données 

 
<Objectif> 
Ce manuel présente les détails relatifs aux points couverts durant l’entraînement en structuration de donnée 

SIG. Outre les différentes fonctions du logiciel ArcGIS et de structuration de données SIG, il inclut les 

modèles SIG (applications) créés par les stagiaires. 

Session 1: Introduction de Système d’Information Géographique (SIG) 

Tout d’abord, l’ objectif principal de cette étude c’est d’introduire le système d’Information 

Géographique(SIG) et ses principaux concepts..Les matières à voir sont : 

1.1 Qu’est ce que le SIG  
1.2 Composant de SIG 
1.3 Application de SIG 
1.4 Données de SIG et Base de données de SIG 
==============================================  

1.1. Qu’est ce que le SIG 
Le SIG consiste en un système d’information de saisie, réserve, extraction, manipulation, analyse et 

création de données géospatiales pour supporter la décision/planification/arrangement de phénomènes 

naturels et humaines. C’est un disque dure intégré, logiciel, et donnée pour atteindre les objectifs voulus. 

L’utilisateur peut afficher, surf, faire des requêtes et visualiser le modèle réçu, tendre et autre relations 

semblable dans les données et faire la création en un format désirable comme par exemple carte, rapports et 

carte marine et figures.  

Le SIG peut être utiliser, normalement avec trois concepts appélés : (i)Base de données ; (ii)Carte et 

(iii)dévéloppement d’Outil de Modelation et Application. Il y a un autre concept qu’on pourrrait appeler  

concept holistique où tous ces trois concepts sont combinés en un seul.  
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1.2. Les Composants de SIG  
SIG a principalement quatre composants 

Saisie de Données: Compiler et traiter les données géospatial à partir de différentes sources 

existantes, telles que les cartes, les images satellitaires, les données géostatistiques et ainsi 

de suite. D’habitude, la compilation est à travers le scanning, numérisation et l’entré du 

clavier. 

La conservation de données et traitement: collationner et organiser les données collectées, 

fournir le traitement pour le rétablissement efficace et actualisation. 

Traitement de Données, analyse et manipulation: Ce système permet l’execution, la 

simulation et modélation, géospatial et géotemporel simple change la découverte,le 

manipulation de données pour supporter  la décision de création de traiter, etc. 

Résultats et Création:L’affiche simple et impression soit des données conservées ou celles 

réçues par la création à partir de l’analyse soit de la carte, figure, tabulaire ou format de 

rapport.  

Il y a beaucoup de programmes de logicielles qui peuvent manipuler les données spatial ou afficher les 

cartes. Le SIG est différent de ces programmes puisqu’il est capable d’assurer l’accomplissement 

d’analyses spatiales. En d’autre termes, SIG est  promptement capable de résoudre les questions ou 

problèmes spatials en utilisant les données géoréférencées (exemple, latitude, longitude). 

Ces quatre constituants sont réunis (figure suivante) par l’utilisateur  pour atteindre à un objectif donné. 

Data Storage
&

Access

Data Input

Data processing, 
analysis & 
manipulation 

Results & 
output 

Data Storage
&

Access

Data Input

Data processing, 
analysis & 
manipulation 

Results & 
output 

Figure1-1: Composants de SIG 
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1.3. Application de SIG 
Il ya une vaste application de SIG dans plusieurs domaines ou disciplines. Il peut être appliqué dans 

n’importe quel domaine où le référence spatial est  jugé nécessaire .Dans le monde entier, il y a des 

événements ou phénomènes qui arrivent au tour de nous, qui ont quelque chose de commun avec les 

facteurs géophysiques et socioéconomiques .La plupart de ces événements ont un rapport directe avec l’un 

ou tous tandis qu’ils ont un rapport indirecte avec l’autre. La liste suivante renferme quelques domaines où 

le SIG est largement utilisé: 

Planification Régionale et Gestion des ressources naturelles y compris les forêts.  

Aménagement du territoire et Urbanisme. 

Logistique, service public, et gestion et planification des utilitaires  

Suivi et monitoring 

Gestion des évaluations 

Gestion des sinistres et plan d'allègement  

Système de soutien des décisions et applications 

……

1.4. Données SIG et Base de données SIG 

1.4.1 Qu’est ce que les Données SIG et Base de Données SIG 
Les données SIG ont un rapport à des données qui possèdent des informations sur les emplacements et 

description de caractéristiques Géographiques. Les deux ensembles de données de SIG peuvent se 

différencier par l’information spatial et/ou attribué, l’échelle sur laquelle ils ont été crée (c. à. d les détails 

d’informations qu’ils renferment), date de création, système de projection de la carte, le model suivi et ainsi 

de suite. Ainsi, de telles variations causent quelque fois de réparation, superposition sur les autres données 

SIG et l’analyse inefficace et même difficile.  

D'autre part, la base de données SIG étant créée en considérant tous ces problèmes connexes, elle facilite le 

stockage efficace et l'analyse des possibilités, ainsi que la recherche par un grand nombre d'utilisateurs. 
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1.4.2 Types de données SIG

Data can be classified while taking various concepts/methods in account, such as: 

i) Raster (réseau) et vecteur 

ii) Spatial et non-spatial 

iii) Primaire et secondaire 

iv) Géophysique, géopolitique et socioéconomique 

v) …….

Il y a en gros deux méthodes principales de stockage des données dans SIG, à savoir vecteur et raster 

(réseau). Selon la nature des caractéristiques cartographiques, point, ligne et polygone sont utilisés pour les 

définir. Les deux formats vecteur et raster sont utilisables pour stocker ces caractéristiques, mais à des 

niveaux de précision différents. Le vecteur, qui stocke les caractéristiques cartographiques à l'aide de vertex, 

est plus précis et principalement utilisé pour les limites légales (par exemple les limites des terres d'une 

zone urbaine, les frontières nationales, etc.) et l'étude des réseaux. D'autre part, le raster (réseau), moins 

précis que le vecteur, qui stocke les caractéristiques cartographiques à l'aide d'une grille de forme régulière 

généralisée, est surtout préféré pour les modèles de terrain numériques, la télédétection, les ressources 

naturelles (carte de distribution des précipitations par exemple), l'analyse statistique, la simulation et la 

modélisation, etc. 

Fig.1-2: Illustration des types de données SIG 

Les données géographiques sont de formes diverses, par exemple point de village, ligne de réseau routier, 

caractéristiques utilisées pour les terres, etc. La base de données SIG a été conçue pour stocker des données 

géographiques sous forme thématique dans la plupart des cas afin de faciliter la recherche et l'analyse. Une 

donnée géographique thématique est spécifique à un item unique, par exemple réserve forestière et parcs 
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naturels régionaux, carte du réseau routier d'un pays, carte de localisation des villages, etc. L'illustration 

schématique de la Figure 1-2 montre différents types de données utilisés pour SIG. 

1.4.3 Format des données SIG

"Format" est un format d'un fichier, et divers formats de fichier peuvent stocker des données SIG. En fait, 

chaque logiciel assistant l'affichage et le traitement des données SIG a généralement son propre format de 

fichier natif. Par exemple, le logiciel "MapInfo" a une extension de fichier .mij, Erdas Imagine un format 

natif .img. D'autres formats de fichier raster (à réseau) sont .tif, .jpg, etc. et les formats de fichier 

vecteur .dxf, .dgn, .shp (format de fichier de forme ArcGIS ESRI), etc.     

ArcGIS a été fourni dans cette Étude. Dans ArcGIS, le fichier de forme (Shape) est un des formats de 

données spatiales, qui peut être utilisé et édité. Le fichier de forme est simple, avec un format non 

topographique qui conserve à la fois les emplacements géométriques et l'information d'attribut des 

caractéristiques géographiques. Pour conserver les informations, un fichier de forme est pourvu de trois 

fichiers ou plus avec extensions de fichier spécifiques qui doivent être conservés dans le même espace de 

travail. Voici quelques-uns de ces fichiers, les trois premiers sont requis : 

i) .shp— C'est le fichier principal qui conserve la géométrie des caractéristiques. 

ii) .shx— C'est un fichier index qui conserve l'index de la géométrie des caractéristiques. 

iii) .dbf— C'est un tableau dBASE qui conserve les informations d'attribut des caractéristiques. 

iv) .sbn and .sbx— Ces fichiers conservent l'index spatial des caractéristiques. 

v) .prj— Ce fichier conserve les informations de système de coordonnées. Utilisé par ArcGIS. 

vi) .xml— Métadonnées pour ArcGIS. Conserve des informations concernant le fichier de 

forme. 

1.4.4 Base de données SIG

1.4.4.1 Standardisation du format des données pour la base de données SIG

Avant de créer la base de données SIG, certains éléments, tels que formats des fichiers de données, 

systèmes de projection, règles topologiques, nomenclature, unité d'analyse, etc. doivent être décidés. 

L'observation des critères décidés permet d'obtenir une bonne base de données SIG qui peut résoudre 

beaucoup de problèmes pour les analyses SIG possibles. Les formats de fichiers utilisables avec ce logiciel 

ont été prévus avec la fourniture d'ArcGIS dans ce projet. 
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1.4.4.2 Sources de données pour la base de données SIG

En principe, il y a deux types de données : 

- Source primaire : Les données créées directement à l'aide de données de source, telles que 

l'imagerie satellite, les vues aériennes ou les données de levé. 

- Source secondaire : Si des données existantes, créées par un autre organisme, sont 

disponibles en tant que source de données. De telles données existantes créées il y a 

longtemps sont parfois vieilles. 

Cette Étude générera une masse de données de source primaire. Toutefois, des données SIG d'une source 

secondaire doivent aussi être développées/utilisées pour développer des modèles SIG. 

1.4.4.3 Nomenclature et Codage
Un code sera assigné à toutes les couches de données SIG produites dans ce Projet. Voir les 

Spécifications pour l'acquisition de données topographiques (1/5.000 et 1/25.000) pour ce Projet. 

1.4.4.4 Recueil de données et métadonnées

Le recueil de données et les métadonnées font partie intégrante de la base de données SIG. Sans eux, 

il est très difficile, parfois même impossible d'utiliser les données pour une analyse SIG  

compréhensible. Un exemple de recueil de données est indiqué ci-dessous. Les métadonnées sont 

définies en tant qu'informations ou données sur les données SIG. Les métadonnées seront présentées 

séparément. 

Dans beaucoup de cas, le tableau du recueil de données pourra être codé ; par exemple, au lieu de 

définir une colonne par "Road (Route)", elle pourra être "RD". Dans ce cas, la signification de "RD" 

sera précisée dans une note. Par ailleurs, la localisation du fichier (répertoire et sous-répertoire) et 

l'explication du nom du fichier (brève description du fichier indiquant ce que sont les données) 

doivent aussi être incluses dans le recueil de données. Si des métadonnées détaillées sont incorporées 

avec les données, le recueil de données pourra être inutile. 
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Table 1-1: Exemple de recueil de données

N˚ S. Nom de donnée Dossier de données Type

1 School_pnt ¥burundi_gis¥point_shp Point

2 River_lin ¥burundi_gis¥line_shp Ligne 

3 Road_lin ¥burundi_gis¥line_shp Ligne 

4 Hospital_pnt ¥burundi_gis¥point_shp Point

5 Lake_pol ¥burundi_gis¥poly_shp Polygone 

6 … … 

1.4.5 Système de projection cartographique de données

1.4.5.1 Présentation de la projection cartographique

Tous les objets ont un emplacement géographique spécifique sur une carte, ce qui permet de les 

localiser sur ou près de la surface de la Terre. Pour décrire cela, un cadre est requis pour la définition 

des emplacements réels. Latitude-Longitude est un tel cadre, qui est utilisé dans le monde entier et 

souvent appelé système de coordonnées géographiques. Il mesure les angles (en degrés) du centre de 

la Terre à un point à la surface de la Terre. Les angles de latitude sont mesurés en direction nord-sud 

avec l'équateur en tant qu'angle 0. Similairement, la longitude mesure des angles en direction 

est-ouest avec le méridien de Greenwich en tant qu'angle 0. 

Il existe aussi un système de coordonnées planaires ou cartésiennes dérivé du cadre mondial, 

également appelé système de coordonnées projetées. À la différence du système de coordonnées 

géographiques, ce système de coordonnées est défini sur une surface plate bidimensionnelle. Comme 

la surface de la Terre est tridimensionnelle, il doit être transformé pour créer une feuille de carte plate. 

Cette transformation mathématique est ordinairement appelée Projection cartographique. Mais une 

telle transformation crée des distorsions dans certains aspects tels que distance, surface, forme ou 

direction. Ces limitations sont couvertes en utilisant des projections cartographiques adaptées à 

l'emplacement géographique prévu. La projection cartographique, ainsi que le sphéroïde et les 

données de référence, deviennent donc des paramètres importants pour la définition du système de 

coordonnées pour les données et la carte SIG. 
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- Sphéroïde : Se base sur l'ellipsoïde, qui est défini soit par un axe semi-majeur 'a' et un axe 

semi-mineur 'b', soit par 'a' et l'aplatissement. 

L'aplatissement est la différence de longueur entre les deux axes, exprimée par une fraction ou une 

décimale. L'aplatissement (f) est : 

f = (a - b) / a 

L'aplatissement est une petite valeur, aussi la quantité 1/f est-elle ordinairement utilisée à sa place. 

- Donnée de référence : Elle définit la position du sphéroïde par rapport au centre de la Terre. 

1.4.5.2 Projection cartographique pour ce Projet (ETUDE SUR L’ETABLISSEMENT D’UNE BASE 

DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE LA VILLE DE BUJUMBURA, 

République du Burundi)

1. Système de projection

Donnée de référence horizontale :

Projection Locale Burundi 

Sphéroïde  WGS84 

Système de référence  WGS84 

Méridien central     30,000 

Latitude de l'origine  0,00000 

Faux Est 500.000m 

Faux Nord 10.000.000m 

Facteur d'échelle au méridien central 0,9999 
Donnée de référence verticale: 

Repère existant localement au Burundi

Sphéroïde 
(Ellipsoïde)

Semi-majeur

Axe

Axe 
M

ineur Axe Majeur

Semi-mineur 

Axe
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1.4.6 Présentation de l'intégration et de l'analyse des données

En général, l'analyse spatiale est toujours un des objectifs de la création de données SIG. Pour cette 

intégration d'une caractéristique avec les autres ou des caractéristiques d’entre les feuilles de cartes sont 

généralement requises. Un certain nombre de points doivent donc être considérés en préparant les données 

SIG pour l'intégration afin d'assurer une meilleure intégration des données SIG. Voici quelques-uns d'entre 

eux : 

- Toutes les données doivent avoir la même projection cartographique. 

- Autant que possible, toutes les caractéristiques doivent avoir été créées à la même échelle, ou bien 

leur différence d'échelle doit être faible. 

- Bien qu'il puisse être très difficile de créer directement tous les ensembles de données requis, il 

faudra vérifier si les données existantes vont bien avec les autres ensembles de données ou non avant 

de les inclure. 
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Session 2: Présentation d'ArcGIS 

Cette session a été prévue en vue de deux objectifs, inclus dans les deux sujets suivants :

2.1 Présentation générale des produits ESRI

2.2 Vue d’ensemble des capacités du logiciel ArcGIS

=====================================================  

2.1. Présentation générale des produits ESRI

ArcGIS fournit un cadre de dimensions modifiables pour l'exécution de SIG par un utilisateur ou un 

grand nombre d'utilisateurs opérant des ordinateurs de bureau, des serveurs, sur le Web, et sur le terrain. 

ArcGIS est une famille intégrée de logiciels SIG prévus pour la création d'un SIG complet. 

ArcGIS Desktop— Une suite intégrée d'applications SIG professionnelles. La plupart des 

utilisateurs reconnaissent la correspondance à trois produits : ArcView, ArcEditor et ArcInfo.

Server GIS— Serveur ArcIMS, ArcGIS et serveur d'image ArcGIS.

Mobile GIS— ArcPad et ArcGIS mobiles pour le calcul sur le terrain

ESRI Developer Network 
(EDN)— Composants logiciels 

intégrables pour les développeurs 

permettant d'étendre les capacités 

des ordinateurs de bureau SIG, 

d'élaborer des applications SIG 

personnalisées, d'ajouter des 

services SIG personnalisés et des 

applications Web, et de créer des 

solutions mobiles.

 
 
 
 
 

Fig. 2-1 Logiciel ArcGIS (Source: www.esri.com )
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Fig. 2-2 ArcGIS – logiciel SIG complet (source : www.esri.com ) 

ArcGIS Desktop: 

ArcView: Cartographie complète, utilisation des données et cartographie, utilisation des données et 

outils d'analyse ; outils d'analyse ordinaires ; édition simple, édition et Géotraitement

ArcEditor: ArcView + édition avancée

ArcInfo: ArcEditor + géotraitement avancé + ArcInfo par station de travail

Fig.2-3 Composants ordinateur de ArcGIS desktop (Source: www.esri.com)
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Extensions ESRI pour ArcGIS 

Les extensions les plus généralement utilisées sont listées ci-dessous. 

ArcGIS
3D
Analyst 

Visualisation et analyse tridimensionnelles. Inclut les applications ArcGlobe et 
ArcScene. Inclut aussi la gestion des données de terrain et des outils de 
géotraitement. 

Inclut une large gamme de caractéristiques de modélisation et d'analyse réseau 
(raster) puissantes qui vous permettent de créer, rechercher, cartographier et 
analyser des données raster sur la base de la cellule. ArcGIS Spatial Analyst permet 
également l'analyse intégrée raster-vecteur. 

ArcGIS
Spatial
Analyst 

Ajoute plus de 200 outils au cadre de géotraitement ArcGIS. 

Vous permet d'effectuer un routage et une analyse de réseau avancés. Appuis :  

L'analyse temps de commande   
Le routage point à point 

ArcGIS
Network
Analyst 

Les directions de route 
La définition de la zone de service 
Le chemin le plus court 
La route optimale   
L'installation la plus proche 
Origine – Destination   

Mobile System: 

ArcPad:
Visualisation/édition des données SIG existantes, y compris l'imagerie.  

Recherche de données, identification et localisation des caractéristiques.  

Mesure de la distance, de la zone et de l'azimutage. 

Navigation, et navigation et "numérisation" avec votre GPS. 

Extraction, conversion, et projection de vos données existantes à l'aide d'un ordinateur de 

bureau ArcGIS ou ArcView 

Database Support: 

ArcSDE: 
Haute performance 

Volumes de données extrêmement importants  

Transactions et versions longues intégrées 
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Appuie toutes les données SIG (vecteur, raster, de levé, de terrain, métadonnées, etc.) 

Appuie de manière cohérente les RDBMS majeurs 

Fait une échelle pour beaucoup d'utilisateurs et bases de données 

Licence: 

Single use license–– une par utilisateur, la meilleure par utilisateur, la meilleure pour l'utilisation 

déconnectée, par ex. sur des ordinateurs portables pour l'utilisation déconnectée et des unités 

de poche.

Concurrent use license–– un certain nombre de licences sur un serveur à utiliser par tout le monde 

sur le réseau. Également appelée licence flottante.

Autre–– par ex. serveur, ensemble serveur-client, ensemble développement-déploiement, etc. 

2.2. Vue d’ensemble des capacités du logiciel ArcGIS 

Cartographie et visualisation 

- Cadres de données 

- Table des matières 

- Légendes 

Gestion des données 

- Définition du système de coordonnées d'un fichier de mise en forme 

- Production d'une topologie de couverture 

- Addition d'un attribut à un tableau 

- Création d'une classe relationnelle qui définit les relations entre les caractéristiques dans la 

couverture et les attributs dans les tableaux INFO 

- Visualisation et édition de métadonnées 

- Survol de données 3D et de la vision Globe 

- Survol et recherche d'informations géographiques 

- Enregistrement, visualisation et gestion de métadonnées 

- Définition, export et import de modèles de données de base de données géographiques et 

d'ensembles de données 

- Recherche et découverte de données SIG sur les réseaux locaux et le Web 

- Création et gestion de schémas de bases de données géographiques 

- Administration de bases de données géographiques ArcSDE 

- Administration d'un serveur ArcGIS 

Édition et compilation de données 
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- Collecte de données incluant l'entrée de nouvelles données dans votre SIG 

- Collecte de données incluant la transformation de données et le maintien de leur intégrité 

- Édition de caractéristiques 

- Édition de tableaux à attributs 

- Ajustements spatiaux 

Géo-traitement 

- Analyse, par ex. tampon, clip 

- Conversion, par ex. forme à raster, forme à base de données géographiques 

- Géo-codage 

- Outils de gestion des données 

- Analyse spatiale 

- Analyse 3D 

- Projection 

Analyste 3D 

L'extension d'Analyste 3D ArcGIS fournit les outils pour la visualisation tridimensionnelle (3D), 

l'analyse, et la génération de surfaces. Avec l'Analyste 3D, les utilisateurs peuvent : 

- Visualiser une surface de multiples points de vue 

- Rechercher une surface 

- Créer une imagerie en perspective réaliste 

- Examiner l'impact visuel de la construction de nouvelles structures 

- Analyser la dispersion de la pollution atmosphérique, en surface et souterraine 

- Visualiser la répartition des revenus dans leur communauté 
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Session 3: Menu et Fonctions de l’ArcCatalog 

L’ArcCatalogue aide par l’apport d’une vue intégrée et unifiée de tous les fichiers de données, bases de 

données et autres documents ArcSIG disponibles pour les utilisateurs d’ArcSIG. L’ensemble de données 

géographiques consiste généralement en un ensemble de fichiers plutôt qu’un simple fichier. Quand il est 

classé dans Windows Explorer, l’ensemble de données apparaît sous forme de liste de systèmes de dossiers 

et fichiers tandis que l’ArcCatalogue affiche et gère les ensembles de données comme des entités simples. 

Ce programme permet de connecter les sources de données, parcourir les espaces de travail, examiner et 

explorer les données, gérer les données, tableaux et métadonnées, rechercher les données et cartes.  

Dans cette session, les points suivants ont étés principalement couverts :  

3.1 La révision  des menus dans l’ArcCatalogue  

3.2. La représentation des données de SIG 

3.3. Vérification des Propriétés des données de SIG 

3.4. Vérification et Création/ Edition de Métadonnées   

Les données suivantes sont placées dans le dossier / training data :

Prise de vue  Aérienne Ortho –rectifiée (une feuille de  carte) en tant que fichier tif
Données de réseau de route Ortho-rectifié en tant que ligne fichier de forme 

  Index de document cartographique en tant que fichier de forme polygone  
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Exercices  : 

3.1. La vue d’ensemble des menus dans Arc Caroloque 
 

i) Ouvre « ArcCatalog »composant de  ArcSIG comme l’indique la fenêtre suivant: 

NB:On peut également l’ouvrir en passant premièrement par “l’Arc Map”  puis en cliquant  

l’icône « Arc Catalog »qui se situe sur la barre d’outils.  

ii) Le programme d’ « Arc Catalog » va s’ouvrir , par exemple : 
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iii) Comme l’on peut remarquer dans cette fenêtre, « ArcCatalog »possède  une Barre d’outils 
avec quelques icônes actives ; c’est la Barre d’Outil standard. 

iv) «  ArcCatalog” a comme Menu principal “file”,”edit” ‘view’,”go”, ‘Géoprossing’, 
‘customize’ , «  window »  et « help » « ArcCatalog » et chaque menu a le menu déroulant 
avec une variété de fonctions. Essayez de s’exercer à ces fonctions ainsi que celles qui 
suivent : 

Nouveau-(sous le Menu «file»), Création du Nouveau Dossier , fichier de forme, 
ect.

Connection du dossier - (sous le menu  « file »), Connection du nouveau dossier à 

l’ArcCatalog.

Mode Personnaliser– (sous le Menu “customize”), afficher la Barre  d’outils, 

Commandes, cette fenêtre va s’afficher telle que :
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Options d’ArcCatalogue-Afficher la fenêtre comme suit et voir les paramètres 
d’options pour afficher, ect. (sous le Menu « customize » 

v) Essayer alors de chercher le dossier qui contient les données d’exercice en passant par à 
gauche de la fenêtre qui affiche la structure de dossier. Double Clic sur le dossier contenant 
les données SIG. Dans la fenêtre d’affichage de Carte, il va se présenter le nom de fichier 
comme le montre la fenêtre suivante : 
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3.2. Représentation de données SIG 

vi) Dans la fenêtre ci dessus, clic sur une donnée par exemple, road shp, ensuite clic Preview, en 
affichant le géographie comme suis :   
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vii) Clic option déroulant situé à droite de « Géography »et sélectionner  « table »,           
en affichant le tableau de ce fichier SIG présenté tel que :    

3.3. Vérification de Propriétés de données SIG 

viii) Maintenant, clic droit sur road.shp, puis  « Propreties »en affichant la fenêtre “ Shapefile 
Properties” contenant le Menu , ‘‘ General’’, ‘‘ XY Coordinate System’’ , ‘‘Z Coordinate 
System’’, ‘‘fields’’, ‘‘ Indexes’’. Ensuite clic sur le Menu ‘‘ XY coordinate system’’ pour 
afficher leur système de coordonnée comme suit : 
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3.4. Vérification et Création /Edition de Métadonnées 

ix) Pour vérifier la Métadonnée, on clic “Description” pour voir  les Métadonnées associées  qui 
peuvent être vide si encore on crée, par exemple :  

Exercice: Créer la Métadonnées road.shp

1) De l’Arc Catalog  , clic Customize sur la barre d’outils  puis clic options ArcCatalog .il va  

afficher les Métadonnées vide comme ci dessus .      

2) Le dialogue“ ArcCatalog options”  apparaît. Clic sur l’Onglet Métadata, en affichant le 

metadata style.      

Créé par l’équipe d’études de JICA 



ETUDE SUR L’ETABLISSEMENT D’UNE BASE DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE 
LA VILLE DE BUJUMBURA 
 

Manuel de structuration de données 

23/81 
 

 Maintenant,clic sur le menu Déroulant,alors vous allez voir  les quatre Styles de types 
Métadonnées.Ceux –ci se différencient par leur description. 
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.Le style Métadonnée identifie  la Métadonnée standard ou profil à suivre. ça control non 
seulement comment vous affichez la Métadonnée mais aussi les pages qui apparaissent pour 
l’édition de Métadonnée dans l’Onglet  Description. 

1. Métadonnée FGDC CSDGM: ça permet d’afficher et modifier la Métadonnée  suivant 
le contenu standard pour les instructions de Métadonnée Géospaciale 
numérique(CSDGM);exporter la Métadonnée dans le format associé avec ce standard, et 
valider ce dernier en utilisant le  CSDGMXMLDTD . 

2. Directive de l’INSPIRE Métadonnée : Ce style permet d’afficher et éditer  un 
document complet de Métadonnée ISO 19139 qui adhères aux règles d’application de 
l’INSPIRE, exporter la Métadonnée dans le format ISO 19139 et le valider en utilisant le 
schémas ISO 19139 XML . 

3. Application des Spécification  de métadonnée ISO19139: Ce style permet d’afficher et 
modifier un document  de Métadonnée complet qui se conforme avec l’ISO standard 
19139, Géographic information  — Métadata —XML Schema implementation, exporter 
la Métadonnée dans ce format ,et le valider en utilisant  les schémas XML standard. 

4.  Description de Rubrique: c’est le style par défaut.il permet d’afficher et modifier la 
description brève de rubrique qu’on peut rechercher dans l’ArcSIG et publier à l’ArcSIG 
en ligne. 

5. Profile de l’Amérique du Nord d’ISO 19115 2003: Ce style permet de d’afficher et 
modifier  un document complet de Métadonnée  qui se conforme avec le North 

american Profile of ISO19115 :2003-Geographic information-Metadata, Exporter le 
Métadonnée dans ce format ,et le valider en utilisant les schémas d’ISO19139XML. 

3) Dans le dialogue “  ArcCatalog option”, sélectionner le North American Profile of 

ISO191152003  et clic apply  enfin OK.      
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4) Sous “Description”, Menus comme ‘print’, ‘Edit’, ‘Validate’, ‘Export’, et ‘Import’  vont 

apparaître.      
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5) Clic l’Onglet ‘Edit’ dans la fenêtre ci-dessus , ça va afficher la fenêtre semblable à celle qui suit. 

La Description des donnée telles que, update, Title , Tags, summary, description et Credits

vont apparaître dans la fenêtre.      

6) Complète ces paramètres, puis clic save.On va finalement avoir des Métadonnées contenant tous 

les descriptions mentionnées .Par exemple:       
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Metadata Sample (Page 1of5)
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Metadata Sample (Page 2of5)
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Metadata Sample (Page 3of5)
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Metadata Sample (Page 4of5)
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Metadata Sample (Page 5of5)
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Session 4: Menu et Fonctions de ArcMap 

L’ArcMap consiste en une application centrale utilisée dans ArcSIG. Celle-ci permet l’affichage et 

l’exploration d’ensemble de données, l’assignation de symboles et la création de disposition cartographique 

pour l’impression et la publication. L’ArcMap est aussi utilisé pour la création et l’édition d’ensemble de 

données.  

L’ArcMap présente des informations géographiques en tant que collection de couches et autres 

éléments au sein d’une carte. Comme cela est présenté ci-après, la liste des couches ajoutées est 

affichée dans la « Data Frame Window » et leur graphique est affiché dans la « Map Display 

Window 

 
Les points ci- après ont  été couverts dans l’exercice 

4.1 Affichage de l’ArcToolBox, Barres d’Outils, Extensions

4.2 Ajout de fichiers

4.3 Propriétés de Couches 
4.4 Affichage de Données Tabulaires

4.5 Affichage de Propriétés de Frames de Données

4.6 Affichage des données / Affichage des couches

4.7 Ajout de données XY

4.8 Enregistrer un fichier couche

4.9 Clic droit dans la Fenêtre d’Affichage de Cartes

4.10 Identifier/joindre et relier les Tables

4.11 Enregistrer des Données Géographiques

4.12 Enregistrer le Fichier Projet

 Les données suivantes sont  placées sous dossier /training data:
Prise de vue aérienne ortho- rectifié (une feuille de carte) en tant que fichier tif
Données de réseau de Route en tant que  fichier de forme de ligne(road.shp)
Route temponnée avec 20m comme fichier de forme polygone  (road_buf20m.shp)
Fichier Excel avec les coordonnés XY (bookl.xls)
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Suivez les étapes suivantes pour l’exercice:  

i) Ouvre “ArcMap”composant de ArcSIG comme c’est présenté ci- après: 

Remarque:On peut aussi l’ouvrir en passant premièrement par l’ “ArcCatalog”  puis click 
l’Icône “ArcMap ”qui se trouve sur la Barre d’ Outil. 

ii) Ça va afficher la fenêtre l’arcMap –ArcInfo  comme suit .La partie gauche s’appelle ‘Data 
Frame (ou Table of Contents) Window’ là où apparaît la liste des données ajoutées, et la partie 
droite s’appelle ‘Map Display Window’ là où s’affiche les données ajoutées de SIG . 

Data Frame/ 
Table of 
Contents 
Window

Map Display 
Window 
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4.1. Affichage d’ ArcToolBox, Barre d’outils , Extensions 
 

-Pour Afficher ArcToolBox: Cliquer l’Onglet marqué suivant .Celui- ci peut  être ouvert en 
cliquant cet Onglet depuis le Menu ‘Geoprocessing’. 

- Pour afficher les Barres d’Outils : Clic droit sur le curseur après avoir maintenu celui-ci à la 

droite de la Barre de Menu, puis cocher la Barre d’Outil désirée pour l’afficher. Elle peut être 

cochée en cliquant dans le Menu « Outils » puis en choisissant « Customize », « Toolbars ».  
- La barre d’outils d’extensions ArcSIG désirée peut être affichée en cliquant dans le menu 

« Outils », l’onglet « Extensions… » et en cochant la barre désirée.

Remarque: Au cas où la licence n’est pas disponible  ça va afficher  échec  de message.
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4.2. Ajout de Fichiers 

- Cliquer sur le bouton d’ajout de données (situé dans la barre d’outils 
standard ou dans le Menu “File” afin d’ajouter un fichier. 

 

4.3. Propriétes de Couches 

- Clic droit en plaçant le cursseur sur la couche dont les propriétés sont à afficher. Puis, cliquer 
la fonction « properties…” en vue d’afficher la fenêtre de « Layer Properties ».Celle-ci 
propose diverses fonction dont le paramétrage de symboles, étiquettes, ect.  
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Exercices: les diverses fonctions sous le Menu, et ceux qui sont sous  
‘Symbology’, ‘Labels’, ‘Selection’. 

4.4. Affichage de Données Tabulaires 

- Faire un clic droit en plaçant le curseur sur la couche dont les propriétés sont à afficher. Puis, 
cliquer sur la fonction « Open Attribute Table » en vue d’afficher la fenêtre de « Layer 
Properties ».  
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4.5. Affichage de Propriétés de Frame de Données 

- Faire un clic droit sur « Layers » dans la « Data Frame Window » puis cliquer sur « Properties » 
en vue d’afficher « Data frame Properties » avec une multitude de paramétrages d’affichage. 
Cette fenêtre peut aussi être affichée en cliquant sur le Menu « View » puis sur l’onglet « Data 
Frame Properties… » 

Exercice : Dans la fenêtre ‘Data Frame Properties’, créer les paramètres comme sous 
‘General’, ‘Data Frame’, ‘Coordinate System’ et remarque les effets. 

 
4.6. Affichage des données/ Affichage des couches 

- Cliquer dans le Menu « View » puis choisir « Data View » ou « Layout view » pour voir les 
données dans chaque environnement.  

4.7. Ajout de données XY 

- Après l’ajout de données de tableaux avec la colonne des coordonnées XY dans la « Data 
Frame Window», clic droit  sur le nom de fichier dans  ‘Data Frame Window’ puis clic 
‘Display XY Data.’.  
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- Ça va afficher la fenêtre ‘Display XY Data’.Choisi le champ droit pour X et Y  sans oublier 
de mettre le Système de Coordonné en cliquant l’Onglet ‘Edit’.Enfin, click  l’onglet ‘OK’. 

- Ça va afficher le point de fichier de forme crée de donnée  XY , par exemple  
“sheet1$ Events” : 

Remarque: Le fichier de forme affiché est temporaire et doit être enregistré dans l’optique de 
l’utiliser prochainement.
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- Pour enregistrer le point de fichier de forme ci- haut crée, clic Droit  sur le nom du fichier ( le 
cas précedent, “sheet1$ Events”) ensuite, clic sur “Data” puis, “Export Data”.  Entre ‘Output 
File name’ et clic l’Onglet OK. 

4.8. Enregistrer un fichier couche 

- Pour enregistrer un symbole affiché, pour appliquer un autre fichier de forme possédant les mêmes 

catégories(ou au même fichier de forme une fois affiché prochainement), faire un clic droit sur la 

couche puis cliquer sur « Save As Layer File… » 
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Remarque:Exécuter le fichier couche enregistré au fichier forme désiré, cela nécessite 
d’importer ce fichier durant la disposition de symboles. 

4.9. Clic Droit dans la Fenêtre d’Affichage de Cartes. 

- Afin d’utiliser des 

fonctions telles que 

l’affichage total, les, 

Zoom In et Zoom out, 

l’identification, etc.,
faire un clic droit en 

maintenant le curseur 

dans « Map Display 

Window ». 
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4.10. Joindre et Relier les Tableaux 

- Joindre ou relier deux tableaux peut se faire à l’aide d’un clic droit sur la couche de données dans 

la “Data Frame window” puis en cliquant sur l’Onglet ‘Joins and Relates’ puis sélectionner soit 
‘Join’ ou ‘Relates’, par exemple sélectionner ‘Join’ présenté ci-après.

 
 

- Sélectionner  les champs joints pour tous  les tableaux  puis clic l’Onglet OK. 
- Ça va joindre le tableau de l’ensemble de donnée à un autre. Par exemple, le tableau de   

road_buf20m  va se joindre à road. 

Remarque: Comme cette jonction est temporaire et pour la jonction permanente, il est 
nécessaire d’enregistre comme nouveau nom de fichier l’ensemble de donnée en 
faisant le clic droit sur le nom du fichier puis en cliquant ‘Data’ puis ‘Export Data’ 
(comme c’est fait au point 7)). 
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4.11. Enregistrer des Données Géographiques. 

Pour enregistrer l’ensemble de données de vecteur on fait de la même façon qu’au point 7).Et pour 

enregistrer le fichier Réseaux, après avoir cliqué sur l’onglet « Export », la fenêtre présentée dans la page 

suivante s’affiche. Dans celle-ci, sélectionner les options désirées. Enfin, cliquer sur « Save ».  

4.12. Enregistrer le Fichier Projet 

- Pour enregistrer le fichier affiché, cliquer dans le Menu « File » puis cliquer sur l’onglet « Save » 

afin de l’enregistrer en tant que MXD.
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Session 5: Menu et Fonctions des Tableaux 

L’ArcSIG contient  des différentes fonctions pour l’ajout et la modification de données tabulaires.  
L’entraînement inclut l’exercice de menus et fonctions en rapport avec les tableaux, telles que: 

5.1 Parcourir les menus et sous-menus 
5.2 Sélectionner, Désélectionner, et Exporter des données   
5.3 Ajouter un champ  

Les données suivantes sont sous le dossier/training data:
Réseau de route en tant que fichier de forme ligne.
Index de document cartographique en tant que fichier de forme polygone.

=====================================================  
Suivez les étapes suivantes comme exercice: 

5.1. Parcourir les Menus et sous-menu. 
 

i) Ouvrir l’ArcMap et ajouter un fichier linéaire forme  

, road.shp.
ii) Dès lors, faire clic droit sur le nom de fichier  “Table of Contents” et cliquer sur“Open 

Attribute Table”, cela affichera  le tableau suivant . 
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iii) Cliquer sur le menu déroulant de l’ ‘options menu’ situé à gauche de Barre d’Outil, il va apparaître 

une rangé de menu de fonction 

5.2. Sélectionner, Désélectionner, Exporter des Données 
 

On peut faire la sélection  en cliquant à gauche de la case désirée puis en cliquant l’autre avec ctrl 

(control) ou shift key comme s’est exigé. 

 Remarque:les cases peuvent aussi être sélectionnées en utilisant la fonction ‘Select by Attributes’.

Pour exporter les cases sélectionnées d’ensemble de donnée  Tabulaire, clic sur menu 
déroulant de l’ ‘optionsMenu’ puis clic sur ‘Export’ ensuite attribuer le nom du fichier sous le 
dossier désiré, enfin cliquer  l’Onglet ‘OK’ . 
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5.3. Ajouter un champ 
 

L’ajout  de champ peut être fait seulement en dehors de l’environnement d’édition. Pour ça, 
clic ‘add Field’, ça va afficher la fenêtre suivant .Saisir le Nom et type de champ avec ses 
propriétés et clic l’onglet OK .ça va ajouter le champ ‘code ’dans le tableau. 

Maintenant clic Droit sur  le champ ‘code’, ça va afficher le menu vertical tel que le suivant. Clic 

sur  ‘Field Calculator’ pour afficher la fenêtre et saisir les données désirées  et clic l’Onglet OK.

Note: Pour saisir les données à une case donnée, il est nécessaire de sélectionner avant le clic 

Droit sur le Champ.
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Pour supprimer le champ, cliquer “Delete Field” puis l’Onglet“Yes” pour confirmer. 

En cas de champ ‘Length’, ‘Perimeter’, and ‘Area’, cliquer sur la fonction ‘Calculate Geometry’. 

Exercice : Les fonctions sous ‘Options Menu’: 
- Sélection et éclaircissement de sélection, et Exportation  des données sélectionnées 
- Ajout de  champ  
- Ajout de champ ‘length’ (ou‘area’ / ‘perimeter’ en cas de fichier de forme Polygone ) . 

Session 6: Familiarisation avec les fonctions importantes d’ArcToolBox 

L’ArcToolBox contient une variété de fonctions pour l’analyse de données SIG y compris la 
conversion. On a les Points/fonctions suivants dans cette session : 

6.1 Introduction à l ’ ArcToolBox 
6.2 Projection et Transformation   
6.3 Conversion des Caractéristiques 
6.4 Contour à TIN, TIN à Réseau 
6.5 Coupure
6.6 Tamponner 
6.7 Dissolution

- Donnée de cet Exercice: 
Les données suivantes sont placées sous le dossier/Data_for_Exercise:

Prise de vue Aérienne Orto-Réctifiée (une feuille de carte) comme fichier tiff
Donnée de Réseau de Route comme fichier de forme linéaire (road.shp).
Donnée de Courbe de niveau  comme fichier de forme linéaire (contour27.shp)

Limite de coupure comme fichier de forme  (clip_pol.shp)
=========================================================== 
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6.1 Introduction à l’ArcToolBox 

La fenêtre ArcToolbox est l'endroit central pour 
trouver, gérer et exécuter des outils de 
géo-traitement.  

Toolbox: A collection of 
toolsets and tools

Toolset: A collection of tools 

Tool: Performs a small 
essential task

La fenêtre ArcToolbox contient des boîtes d’outils, 
qui contiennent à leur tour des outils et les 
ensembles d'outils (un ensemble d'outils sont juste 
un dispositif organisationnel, comme un dossier 
système).  
La fenêtre ArcToolBox peut être affichée  depuis 
l’ArcMap ou l'ArcCatalogue. Cliquer sur le bouton 
de la fenêtre de l’ArcToolbox sur la barre d'outils 
Standard. 

6.2 Projection et Transformation 
L’ArcToolBox a de nombreux outils liés à la Projection et à la Transformation.  
Pour afficher ces outils, ouvrez la fenêtre ArcToolBox – Cliquez sur « Data Management 
Tools »- puis cliquez sur « Projections and Transformations » (Comme marqué ci-dessous).  

Des outils séparés sont disponibles pour les Caractéristiques (Vecteur) et l'Ensemble de 
données de réseaux, avec les outils communs « Create Custom Geographic Transformation » 
et « Define Projection » aux deux ensembles de données. 

Exercice: Appliquer la fonction “Project” à road.shp (pour changer à une autre 
système de projection, comme système de coordonné Géographique. 
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6.3 La Conversion des caractéristiques : 

Les Outils pour convertir un type de Caractéristique à un autre comme de la Ligne au Polygone ou 
vice versa, ect…, peuvent être atteints en cliquant sur « Data Management Tools » et « Features » 
ensuite comme marqué dans l’image de côté. 

 

Exercice: Ajouter les coordonnées  XY  au fichier de forme 
Point (point27.shp). 

Cliquer ArcToolBox - Data Management Tools - Features - 
Add XY Coordinates 

Attribuer pont27.shp comme Input features (comme  suit) 
puis cliquer l’Onglet OK. 
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6.4 Contour à TIN, TIN à Réseau  

Le Triangulated irregular network (TIN) est crée à partir de donnée 
de vecteur saisie, qui représente les différents caractéristiques de 
surface. On peut ajouter les données de vecteur en utilisant  tous les 
deux TIN crées et Editer les outils de TIN. 
Ces fonctions sont disponibles  sous le toolbox “3D Analyst Tools”.
Utilisez l’outil de géo -traitement de TIN crée dans l’optique de 

Exercice

construire un nouveau TIN sur disque .Une fois  le TIN est crée sur 
disque, utilisez l’outil de géo-traitement de TIN crée pour ajouter 
les données de vecteur ajoutées à un nouveau TIN. 

: Convertir les données de  contour (contour27.shp) à TIN puis de TIN au 
Réseaux.
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Pour convertir les lignes de contour à TIN: ArcToolBox - 3D Analyst Tools – TIN Management – 
Create TIN
Pour convertir TIN au Réseau: ArcToolBox - 3D Analyst Tools – Conversion – TIN to Raster
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6.5 Coupure 

Exercice: couper les données de route en utilisant  clip_pol.shp
Pour les caractéristiques de coupure : ArcToolBox - Analysis Tools – Extract – Clip

Pour la coupure de Réseaux: ArcToolbox - Data Management Tools – Raster - Raster 
Processing - Clip 
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6.6 Tamponner 
Pour le Tamponnage: ArcToolbox - Analysis Tools – Proximity - Buffer

Exercice: Tamponner  les données de route (road.shp) avec seuil.

6.7 Dissolution
Pour dissoudre : ArcToolbox – Data Management Tools – Generalization - Clip

Exercice: Dissoudre le résultat de Route tampo déjà crée.
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================================================  

Exercice: Supposons que le gouvernement local veut catégoriser  les terrains en se 
basant sur la distance depuis la route, et les trois valeurs de seuil  sont 20m, 40m et 
50m.Dévéloppez la catégorisation de terrain. 

Tamponner la route avec ces critères  séparément puis dissoudre.  
Ensuite, combiner la zone entière et ces trois résultats en série montrant quatre 
catégories en utilisant la fonction “Update” (ArcToolBox – Analysis Tools – Overlay – 
Update).

Session 7: Les Requêtes des Données 

Cette session comporte  les façons de construction  logiques de Requête en ArcSIG et 
l’extraction des caractéristiques sélectionnées ou attribuées à un nouveau fichier.  

  Les matières sont les suivantes: 
7.1 Qu’est  ce que  la requête des Données ? 
7.2 Construction logique de requête en vue de sélectionner les caractéristiques. 
7.3 Exportation des caractéristiques sélectionnées à un nouveau fichier. 

Les données suivantes  sont placées sous le dossier /training_data: 

Les Données de caractéristiques linéaire comme fichier de forme (line27.shp).
Les données de Route comme fichier de forme (road.shp).

7.1 Qu’est ce que la Requête des Données ? 
La recherche d’information dont on a besoin en appliquant les opérateurs logiques et expressions 
mathématiques est d’habitude  voulue pour les types de données d’analyse et modélisation de 
plus simple au complexe. Par exemple, une simple expression est présentée comme suit : 

"Layer” = ‘3005’ 

7.2 Construction logique  de Requête pour sélectionner les caractéristiques.  
Lorsqu’on effectue une requête de donnée, on fournie  l’expression correcte en utilisant le critère 
logique puisque la requête  mal construite pourrait devenir  la donnée qui n’est pas la même à 
celle que l’utilisateur cherche.  

Pour ça, en ArcSIG, les plus communs opérateurs tels que “And”, “Or”, “Not”, sont disponibles. 
On peut aussi utiliser les opérateurs  mathématiques.  
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Suivez les  étapes  suivantes  pour l’exercice: 

x) Ouvrir “ArcMap” et ajouter les données par exemple, line27.shp.

xi) Clic(Droit) sur la couche dans “Table of Contents” et clic “Properties”. Puis clic sur 
“Definition Query” dans la fenêtre, ça va apparaître comme ça: 

Créé par l’équipe d’études de JICA 
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Remarque: On peut 
alternativement ouvrir le 
constructeur de requête en 
cliquant sur l’icône à 
gauche du tableau attribuer 
et sélectionner  “Select By 
Attributes”comme suit : 

xii) Clic sur “Select By Attributes”. La fenêtre “Select By Attributes” va apparaître. Clic sur 
rubrique “Entity”  puis clic sur le bouton “Get Unique Values”, ça va afficher les valeurs 
de ce rubrique comme ‘2DPolyline’ and ‘Insert’.Maintenant, clic deux fois sur le rubrique 
“Entity”, puis une fois sur “=”,ensuite deux fois sur  ’2DPolyline’, et enfin clic sur 
l’Onglet “OK”. 

xiii) Ça va afficher seulement les lignes avec “Entity” = ‘2DPolyline’, comme le montre 
la fenêtre suivante : 

Créé par l’équipe d’études de JICA 
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xiv)Maintenant, Ouvrez  le tableau attribué de ce fichier, vous allez trouvé seulement le 
registre qui rencontre ce critère. 

Practice: SiD’une manière semblable, essayez de développper l’autre requête et observez le 
résultat (par exemple, en utilisant “Entity” comme‘2DPolyline’ et “Layer” voulue).On peut aussi 
essayer en affichant les données de Route. 

Exercice: Fait quelques Requêtes logiques à partir du tableau  et exporte les données 
sélectionnées. 
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7.3 Exportation des caractéristiques sélectionnées à un nouveau fichier. 

Les données sélectionnées avec l’expression de requête peuvent être exportées dans le nouveau 
fichier en créant de nouveau ensemble de données.  

Exporter les lignes ci- haut sélectionnées au nouveau fichier:
i) Clic Droit sur la couche en “Table of Contents”, puis clic Droit sur le couche, après choisi sur 

“Data”, enfin sur  “Export”. La fenêtre “Export Data” va apparaître ici: 
- Composer l’option “Export” comme “All Features”  
- Vérifier sur “This layer’s Source Data” pour préserver le système de coordonné. 
- Mettre le nom du fichier crée sous le dossier voulu. 
- Enfin, clic “OK”. 

-Ouvrir le fichier nouvellement crée et observer le résultat. 

Remarque:Si vous savez les caractéristiques à exporter au nouveau fichier, la façon la plus 
simple pour exporter ces caractéristiques  est de sélectionner en passant par  l’icône 
“Select Features by clicking (using “Select by Rectangle” Tab) or Dragging a box » situé 
dans la Barre d’Outil. Ça va éclaircir les caractéristiques sélectionnées. Par exemple:  
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Ensuite on suit l’étape répété ,mais maintenant ,on a besoin de sélectionner “Selected 
features” comme option “Export” telle que la fenêtre suivant le montre : 

Après l’enregistrement à un nouveau fichier, ouvrez le et observez le résultat. 

Exercice: Sélectionnez alternativement les caractéristiques voulus à partir du Tableau Attribué et 
exportez de la même façon que celle-ci-dessus.
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Session 8: Création et Extraction de nouvelles Données de Couches 

Cette session comporte les méthodes de création de nouvel ensemble de données et la saisie de 
données en SIG.  

Les matières sont: 
8.1 Création d’un nouvel ensemble de données  
8.2 Saisie de données 

- Données de cette exercice: 
Les données suivantes sont sous le dossier /training_data:

Ortho-photo of map sheet 24 as Tiff file

================================================================  

8.1 Création d’un nouvel ensemble de données 

Quelques méthodes de création de nouvel ensemble de données ont été déjà introduites. Ici, la 
création de fichier de forme vide va s’exercer avec quelques  caractéristiques de numérisation 
comme point, ligne et polygones. 

Fichier de forme vide: On a eu des occasions où on avait besoin de créer le fichier de forme 
vide. Un tel fichier est le couche qui n’a pas de caractéristique géographique mais qui a de 
définition comme système de projection, ect. 

Dans cet exercice, vous créerez les fichiers de forme avec le type de caractéristique 
comme point, ligne et /ou polygone.  
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i) Ouvrez ArcCatalogue, entrez dans le dossier où vous voulez crée  une nouvelle couche de 
donnée. Puis cliquez le Menu où vous voulez créer ‘File’ -> ‘New’ -> ‘Shapefile’. 

ii) La fenêtre suivante s’affichera. Attribuer par exemple le point “Name”, “Feature 
Type”.Puis cliquer“Edit”pour mettre le système de projection. 
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La fenêtre suivante s’affichera. 

iii) Cliquez “Select” dans la fenêtre ci- dessus pour sélectionner un système de projection. Pour ça, 

allez aux systèmes de coordonnée projetés et sélectionnez Projection pour ce Projet. 

Créé par l’équipe d’études de JICA 



ETUDE SUR L’ETABLISSEMENT D’UNE BASE DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE 
LA VILLE DE BUJUMBURA 
 

Manuel de structuration de données 

63/81 
 

Créé par l’équipe d’études de JICA 



ETUDE SUR L’ETABLISSEMENT D’UNE BASE DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE 
LA VILLE DE BUJUMBURA 
 

Manuel de structuration de données 

64/81 
 

Créé par l’équipe d’études de JICA 



ETUDE SUR L’ETABLISSEMENT D’UNE BASE DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE 
LA VILLE DE BUJUMBURA 
 

nuel de structuration de données 

65/81 
 

Créé par l’équipe d’études de JICA 

Ma

Changez le Merdien Central à 30.000 et le facteur d’échelle à 0.9999. 

1
2



ETUDE SUR L’ETABLISSEMENT D’UNE BASE DE DONNEES TOPOGRAPHIQUES NUMERIQUES DE 
LA VILLE DE BUJUMBURA 
 

Manuel de structuration de données 

66/81 
 

Cliquez “Apply” puis l’Onglet “OK” dans la fenêtre “Projected Coordinate System Properties”. 

iv) Ensuite, cliquez ‘Apply’ dans  ‘Spatial Reference Properties’, enfin cliquez “OK”. Le 

paramètre de projection sélectionné s’affichera comme suit: 

1

2

v) Cliquez “OK” dans la fenêtre suivante. 
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vi) Cela créera le fichier de forme vide nommé New_shapefile_pnt. D’une manière semblable, 

exercez- vous au fichier de forme avec “Feature Type” en tant que Ligne et fichier de forme 

avec “Feature Type” en tant que Polygone. 

Exercice: Créer le fichier de forme de type ligne et fichier de forme de type polygone 
de la même façon. 

8.2 Saisie de données 

Le fichier de forme vide peut être aussi utilisé pour la saisie de données souhaitées. Par exemple, 
le fichier de forme vide est ouvert et les données sélectionnées à partir de couche existante 
peuvent être copiées et collées puis enregistrées dans le fichier de forme vide. En plus, les 
données peuvent être saisies à partir de la source de données primaire par la numérisation. 

S’exercer d’introduire de petit bâtiment en tant que données de point, route en tant que 
données de ligne et parcelle en tant que données de polygone à partir de l’Orthophoto 
existant. Suivez les étapes suivantes pour cet Exercice:

La saisie de données se fait selon les étapes suivantes: 

i) Ouvrir “ArcMap” puis ajouter une Orthophoto (Map sheet 24).  
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ii) Ajouter le fichier de forme créé (vide) pour numériser l’emplancement de petit bâtiment.  

iii) Alors, cliquer “Editor” dérouler le menu depuis la Barre d’outils “Editor” et cliquer “Start editing” 

puis  cliquer l’Onglet “OK” dans la fenêtre apparue. Les icônes de la Barre d’Outils   “Editor” 

deviennent actives, changer la tâche à l’aide de “Create New Feature” comme suit : 

iv) Cliquer “Editor” et sélectionner “Start Editing”, puis, “Create Features” la boîte de dialogue 
apparaît à gauche de la fenêtre “ArcMap”.Dans ce dernier, double clic sur “bldg_pnt”, cela 
affichera le dialogue “Template Properties”dans la fenêtre carte et “Construction Tools” avec 
l’outil“Point” sous le dialogue “Create Features”  comme suit :

Cliquer l’Onglet “OK” dans le dialogue “Template Properties” pour le déplacer.

v) Tout d’abord, «Zoom In » de l’Orthophoto et rechercher l’emplacement  de petit bâtiment. 

Puis, cliquer l’Onglet “Point” dans  “Construction Tools” et cliquer au centre de petit bâtiment. De 
la même façon, continuer d’ajouter d’autres emplacements de petits  bâtiments en tant que point. 

vi) Pour sélectionner ceux qu’on veut,, cliquer “Edit Tool” et  cliquer le bouton “Delete”  du clavier si 

on veut effacer. 

vii) Pour enregistrer le travail de saisie, cliquer “Save Edits” à partir du menu déroulant de “Editor” et 

pour l’arrêt de l’édition, cliquer  sur“Stop Edits” à partir du menu déroulant “Editor”. 
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viii) De la même façon, s’exercer à introduire des routes dans le fichier de forme avec des types de 

données comme polylignes et limites de blocs dans les fichiers de forme avec types de données 

comme polygones.  

La Saisie de Route en tant que Ligne : L’environnement du début de la route_lin.shp va être 

semblable à celui ci: 

- Paramétrer la distance de capture avant la numérisation comme le montre la fenêtre 

suivante: 
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- En général, “Line” ou “Freehand” exigera d’utiliser pour saisir la route. Double clic finira la 

saisie de section de route. 

- Utiliser l’outil prolonger sur la barre d’outil d’édition Avanceé . 
- Utiliser l’outil d ‘émergement sur la barre d’outil d’édition Avancée  

Parcelle en tant que Polygone: L’environnement du début de la route_lin.shp va apparaître 

comme celui-ci : 

- Paramétrer la distance de capture avant de commencer la numérisation comme c’est déjà 

mentionné . 

- Utiliser l’outil auto complete polygon  pour numériser le polygone adjacent .
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Session 9: Vue d’ensemble des couches de ce projet et de creation de 
schémas pour les base de données SIG 

Il existe environ 169 types (sur une échelle de 1:5,000 ) et environ 156 types(sur une échelle de 1:25,000) 

de couches utilisées pour compiler les cartes topographiques de ce projet. Toutes les couches ont besoin d’ 

aller à travers des couches en vue de déterminer  leur mode de regroupement pour la création de schémas 

pour les bases de données SIG. 

En général, il n’y a pas de règle stricte quant au nombre de couches ou quelle couche doit être intégrée dans 

un groupe (insérer dans un fichier forme). Cependant, il est important de se rappeler que les couches avec 

des données similaires peuvent être associées ensemble. Ainsi, une couche polygonale peut être associée à 

un polygone ou une couche linéaire avec des lignes ou couches de points avec points. De plus, les couches 

de même catégorie sont meilleures à être regroupées ensemble. Par exemple, les couches polygonales de 

catégories végétales doivent être associées avec des couches polygonales de même catégorie. Les couches 

de contour ayant des informations sur l’élévation doivent plutôt être traitées séparément. Considérer ces 

points le tableau suivant présente une possibilité de regroupement de 169 couches (sur une échelle 

de1 :5000) en 23 fichier de forme et de 156 couches(sur une échelle de 1 :25,000) en 21 fichier de forme.
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Session 10: La Conversion de données CAD en fichiers de forme 

Cela comporte un exercice sur plusieurs étapes de conversion des données CAD de ce projet en fichiers de 

forme.

Les données d’Exercice: Les données CAD  de document cartographique 24, 25, 26, 27 comme 
fichier dwg  (24.dwg, 25.dwg, 26.dwg, and 27.dwg).

Deux méthodes de conversion sont présentées ci-dessous avec certaines étapes modifiées dans la seconde. 

Les étapes sont comme suit : 

Procédure I:

1) Vue d’ensemble des couche SIG du projet JICA (comme cela est mentionné dans la session9

précédemment).  

2) La formulation des fichiers et leur structure en considération des points suivants :  

- Arrangement des couches en fichiers de forme  

- Dénomination des fichiers de forme  

- Création de dossiers/ Structure de fichiers, des exemples sont présentés ci-dessous : 

GIS_data

msh_XV1a_16 msh_XV1a_17

road_pol

road_lin

bldg_pol

admin_lin

road_pol

road_lin

bldg_pol

admin_lin

GIS_data

msh_XV1a_16 msh_XV1a_17

road_pol

road_lin

bldg_pol

admin_lin

road_pol

road_lin

bldg_pol

admin_lin

road_pol

road_lin

bldg_pol

admin_lin

road_pol

road_lin

bldg_pol

admin_lin

5k_msh24 5k_msh25

gis_data
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3) Création de fichiers de forme selon le schéma suivant : 

i) Fichier de forme – route _pol.shp

 

ii) Pour fichier de forme - route _lin.shp

 

iii) Pour fichier de forme- bldg_pnt.shp

iv)  Pour fichier de forme - cont_lin.shp

 

v)  Pour fichier de forme - contl_pnt.shp
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Precision 4 

Description des champs ajoutés:

Créé par l’équipe d’études de JICA 
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- Création ci-dessus de cinq (5) fichiers de forme avec colonnes autres que les FID e es 

- e par le projet JICA.  

ensemble de fichiers de forme pour un document 

- le des paramétrages des fichiers de forme à un autre document 

) Affichage des fichiers CAD et préparation de ces derniers à leur conversion. 

de“Layer Properties” puis en cliquant sur le 

t form

similaires à ce qui est précisé plus haut.  

Définir la projection comme celle désigné

- Puis, copier le fichier et le renommer.
- Ainsi, créer tous les paramétrages l’

cartographique.

Copier l’ensemb
cartographique.

4

- Afficher les fichiers CAD. 
- Décocher les couches en affichant la fenêtre 

menu “Fields”. 
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Remarque:Comme le champ ‘Elevation’ est exigé pour le contour ligne et données de points de 

contrôle,cocher aussi ce champ. 

- Enregistrer le fichier ci-dessus en un fichier de forme temporaire (dans une optique de 
travail) en sélectionnant « Data » puis « Data Export » dans la « Data Frame Window ».  

- Définir la projection de ce fichier de forme.  
- Afficher ce nouveau fichier de forme. Ajouter les colonnes requises dans le schéma du 

point 3) dans la même séquence.  

- Transférer / calculer les données attributs dans la colonne créée. 

5) Transférer les données vers les fichiers de forme requis : 

- Afficher le fichier de forme vide requis.  
- Sélectionner les couches requises dans le fichier de forme créé temporairement. 
- Lancer l’Éditeur puis copier d’abord les couches depuis le fichier de forme créé 

temporairement. Ensuite, coller dans le fichier vide.    

- « Save edits » puis « Stop editing ». Ainsi, le fichier de forme requis aura ses propres 
données.    

- De la même façon, répéter ce processus afin d’enregistrer les autres couches requises par 
les autres fichiers forme.  

Ainsi, le processus de conversion est terminé.  
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Procédure II (une autre méthode de conversion):

Au lieu de la création de fichiers de forme vides, après la création de fichiers de forme temporaires 

(intermédiaires) avec toutes les colonnes nécessaires, les couches désirées peuvent être choisies en utilisant 

la « Definition Query ». Cela est compris dans la procédure alternative.  

1) Vue d’ensemble des couche SIG du projet JICA (comme cela est mentionné dans la session 9

précédemment). 

2) La formulation des fichiers et leur structure en considération des points suivant:

- Arrangement des couches en fichiers de forme (par exemple, voir les Tableaux 9.1 et 9.2) 

- Dénomination des fichiers de forme (par exemple, voir les Tableaux 9.1et 9.2) 

- Création de dossiers/ Structure de fichiers, des exemples sont présentés ci-dessous : 
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GIS_data

msh_XV1a_16 msh_XV1a_17

road_pol

road_lin

bldg_pol

admin_lin

road_pol

road_lin

bldg_pol

admin_lin

GIS_data

msh_XV1a_16 msh_XV1a_17

road_pol

road_lin

bldg_pol

admin_lin

road_pol

road_lin

bldg_pol

admin_lin

road_pol

road_lin

bldg_pol

admin_lin

road_pol

road_lin

bldg_pol

admin_lin

5k_msh24 5k_msh25

gis_data

3) Affichage de fichiers CAD et préparation de ces derniers à leur conversion. 

 
- Afficher le fichier CAD ; point/polyligne/polygone.

- Décocher les couches en affichant la fenêtre “Layer Properties”puis en cliquant sur le menu 
“Fields” et ‘Check off’ les champs indésirable. (Garder les champs tells que, FID, Shape, 
Layer, Identity, Handle, Color, et Elevation Cauchés).

- Exporter les données pour les enregistrer en tant que nouveau fichier de forme . 
- Définir la Projection de ce Projet 
- Convertir le Polyligne ZM au Polyligne:Pour ça, cliquer ArctoolsBox – Data Management 
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Tools – Features – Feature to Line (si le fichier de forme enregistré ci-dessus est de 
caractéristique ligne). De la même manière,on a besoin de choisir, charactéristique point si le 

fichier de forme est Point et caractéristique Polygone si le fichier de forme est Polygone. 

L’incapable Z et valeurs de M dans l’environnement comme présenté ci- dessous. 

- Ajouter les colonnes requises comme suit : 
Pour le caractéristique Point: Code, couche_des, Elévation, Remarque 
Pour le caractéristique Ligne: Code,couche _des, Elévation, Longeur, Remarque. 
Pour le caractéristique: Code,couche _des, Périmètre, surface, Remarque 

- Maintenant, décaucher les autres champs autre que ci-dessus plus FID et forme. 
- Séléctionner les caractéristiques utilisant ‘Definition Query’ dans‘Layer Properties’ puis  

Exporter pour enregistrer au nom de fichier de  forme désigné. 
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